GUIDE TO SECOND LIFE®

TIPS, TRICKS, AND MUST-TO-KNOWS FOR MAXIMIZING THE VALUE OF YOUR VIRTUAL WORLD EXPERIENCE
Table of Contents

Welcome to the Second Life Grid ........................................................................................................... Page 1
Getting Into Second Life – Requirements ................................................................................................. Page 1
Firewalls ................................................................................................................................................ Page 1
Getting Started.......................................................................................................................................... Page 2
Join Our Group!......................................................................................................................................... Page 7
Learn to Walk, Fly, Sit, Teleport ............................................................................................................... Page 10
Voice in Second Life ................................................................................................................................. Page 12
  What You Need to Use Voice................................................................................................................... Page 12
  Enabling Voice......................................................................................................................................... Page 12
  Proximity-Based and Group Voice Chat..................................................................................................... Page 13
  Increasing Voice Volume – Speaker / Presenter..................................................................................... Page 14
Chat: How to Talk with Text...................................................................................................................... Page 15
IM or Instant Messaging in SL .................................................................................................................. Page 16
Audio/Video and PowerPoint in Second Life ........................................................................................... Page 17
Using Your Camera (VERY IMPORTANT)................................................................................................ Page 18
  Camera View........................................................................................................................................ Page 18
  Mouse and Keyboard Controls ................................................................................................................ Page 18
Landmarks aka How to Get Back To That Place You Liked ................................................................. Page 19
  Teleporting Within a Sim or Sims (Island).............................................................................................. Page 21
Changing Your Appearance....................................................................................................................... Page 22

Second Life Grid™, Second Life®, and SL™ are trademarks of Linden Research, Inc.
World2Worlds, Inc.™ and W2W™ are trademarks of World2Worlds, Inc.
Welcome to the Second Life Grid™!

Second Life® has proven to be an excellent platform for conferences, panel discussions, presentations, education and training, business and corporate meetings, recruiting, research, and social networking. We at Kelley Executive Partners and World2Worlds, Inc.™ (W2W™) hope you’ll find this guide helpful in your entry to the 3D virtual world platform we’ve embraced as an everyday business tool.

While under contract to CMP (now UBM ThinkServices) W2W hosted a live broadcast for MIT’s Emerging Technologies Conference in September 2007, accommodating an additional 140 people from around the globe who wouldn’t have been able to participate otherwise.

This Onboarding Guide has been developed to assist you in maximizing your experience. We strongly encourage you to read through this entire document to insure a successful start in your exploration and use of this 3D virtual space.

Getting Into Second Life – Requirements

- Broadband (or LAN) a must!
- QuickTime a must, so please be sure the latest version is installed on your computer.
- Check and make sure your graphic drivers and your DirectX are current.
- USB Headset a must if you want to use voice for meetings, conferences or just to chat.

Firewalls

If you have trouble entering Second Life, please check the following with your IT department:

Second Life needs to connect to ports 443/TCP, 12043/TCP, 12035/UDP, 12036/UDP, and 13000-13050/UDP. You should configure your firewall to allow outbound traffic on those ports, and related inbound traffic. If you need additional help with this, let us know or contact Linden Lab.
Getting Started

To begin, you need to download the Second Life client. To download the Second Life client and create a free account, copy the following into your web browser:

http://secondlife.com/community/downloads.php

Once you’ve downloaded the “client” or software program (Fig-1), insure your USB headset is already plugged in if you want to use SL Voice (if not, don’t worry about it, we can do this later) BEFORE you open the Second Life client. Install Second Life.

Double click the Second Life icon that should be on your desktop now. You will see a place to enter your AVATAR name and password. You do not have one yet. Choose “Connect” (Fig-2).

A new box will appear on your screen stating, “You must create a Second Life Account to connect.” It then asks you if you’d like to create an account. Select OK (Fig-3).
A new screen will appear where you’ll select a pre-made avatar. (Fig-4) and then enter your personal information. Choose a default avatar (you may customize it to your satisfaction later if desired.)

Create your avatar first name and choose a last name. You may get a message that your name isn’t available. Try a different first or last name until you are satisfied - **write this all down!**

One of the most common errors people make is re-entering their information when they log in and find their name or password doesn’t work. Remember that this is the name you’ll be known by in Second Life and in the business world.

Contact Rissa Maidstone or John Zhaoying in Second Life, (Kim Smith and John Jainschigg in the physical world) for assistance with this, if needed. Contact information is: ksmith@world2worlds.com or jainschigg@world2worlds.com.

**VERY IMPORTANT HINT:**

**Naming Your Avatar**

Name your avatar (your digital representation of you that you’ll create on entry to Second Life) from a business perspective. At this time you have no choice in choosing a last name—they’re provided for you to choose from. Because of this, we recommend you name your “business” avatar with your first name OR with your first name and last name (KimSmith Kanto, for example, Kanto being a Linden Lab provided last name.) Of course you can choose any first name you wish.
1. **CHECK YOUR EMAIL**—you will receive a confirmation email that you must respond to by clicking on the link enclosed (Fig-5). The email will have been sent to you by no-reply@secondlife.com. It may be in your junk email folder, so be sure to check there as well as your regular email. The email arrives almost immediately. Open the email and click on the link within to activate your account. (Fig-6). **DO NOT PROCEED WITH THE NEXT STEP** that occurs when you activate the link in your email. Select Cancel. Now go back to your Second Life window that should still be open.

**Welcome to Second Life, World2WorldsGuest1 Mubble**

no-reply@secondlife.com

**Sent:** Sun 8/31/2008 3:20 PM  
**To:** ksmith@world2worlds.com

Welcome to Second Life, World2WorldsGuest1 Mubble! Please keep this email in case you need to retrieve your account name later.

**Account Name:** World2WorldsGuest1 Mubble

**CLICK HERE TO ACTIVATE YOUR ACCOUNT:**

https://join.secondlife.com/activate.php?id-5a41e13d-5de9-4fd5-80bf-b4116c6c75d

(If you are unable to click the above link, copy and paste it into your browser.)

2. Enter your **Avatar First Name** and **Last Name**, and your **Password**.

3. **Starting Location:** type in (exactly as shown) **Kelley Executive Partners**

4. Select “**Connect**”.

5. Another pop-up will appear with the Linden Lab “Terms of Service” agreement. Select “I agree” after reading it.

6. You’re in-world!
Once You’re In-world...

If you need additional assistance, use the “Search” button at the bottom of your screen, select the People tab and search for **Iyiy Levee (real-life: Candace Chou)**. (Fig-7) Select the name you searched for. The person’s Profile will appear on the right hand side in the Search box.

![Image](https://example.com/image.png)

There is an instant message (IM) button within that profile. Click on instant message, type your question in the chat line of the box and press send or use your return key.

Remember to tell us your real name and title so we know who you are! (Fig-8) If we’re not in world, please follow the next step.
NOTE: If you arrive in Second Life and are NOT on iUST Region Island, click the Map button at the bottom of your screen (Fig-9) and your cursor will be inside a box with the name of your current location in it. Enter ‘iUST Region’ click search, and then click on the “teleport” button. (Fig-10)
Next Step: Join the World2Worlds Events Group and other inworlds activities

Use Search – Groups (groups are like professional associations). Type in the following: **W2W Events** exactly as shown. Two groups will appear on your screen. (Fig-11) Click on the W2W Events link. Click the “View Full Profile” button (Fig-12). A new pop-up will appear on your screen (Fig-13). There will be a JOIN button. Left click on the Join button.

Check class wiki for other calendar events. http://ustsl.pbworks.com
This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.

Figure 11

Second Life® Guide

This enables you to receive announcements about our events, conferences, lectures, tours, parties, live music, and social networking events.
Figure 13
Learn to Walk, Fly, Sit, Teleport

Movement in Second Life is relatively easy. You can use your cursor keys to move forward (up arrow), backward (down arrow) and turn right or left (right or left arrow keys), or, you can use the movement panel supplied with Second Life as shown here (Fig 14).

If these are not on your screen, select the View Menu (Fig 15) in the upper left hand corner. Select “Movement Controls” and they’ll then appear on your screen.

Movement Guide

✓ Walk and turn with arrow keys
✓ Fly with PgUp/PgDown (and arrow keys to change direction)
✓ Sit (right-click on chair, select ‘Sit Here’)
✓ Teleport (various methods and UIs)
Sitting

Take the weight off your virtual feet by sitting down in Second Life. To sit down, right-click on something and select the “Sit Here” (Fig-16) option or left click if your mouse pointer turns into a chair while hovering over an object or teleport.

When you’re ready to get up again, click the “Stand Up” button on the bottom of the screen. (You can also right-click on your avatar to get to the “Stand Up” option.)

Flying!

Walking everywhere is a thing of the past. Physics in Second Life allow you to fly which is MUCH faster than walking. Because it’s so much faster you’ll find yourself flying into some strange places on accident, so be careful!

To take off, press and hold Page Up key. To land, press and hold the Page Down key. Once you’re in the air, use the same keys as you use to move around on the ground, along with Page Up and Page Down to fly up and down. You can also click the “Fly”/”Stop Flying” button at the bottom of your screen to start and stop flying. Try it now and fly around the island and back.

Additional Help

For additional help, open the Help menu at the top of your screen. Select Tutorial (Fig-17).
Voice in Second Life

What You Need to Use Voice

In order to use Voice which allows you to talk to other people rather than typing text, make sure you have a set of (USB preferred) stereo headphones with a microphone that works well on your computer. We have tested many brands and most work well, but you will have the best results with digital USB models like those from Plantronics and Logitech.

Enabling Voice

Please note that voice is on by default when you download the Second Life client. However, just in case, to turn voice ON, select Edit at the top of your screen on the left. Select Preferences (Fig-18). Select Voice Chat and insure that the “Enable Voice” box is checked (Fig-19). In addition, please be aware that Push-to-Talk is on by default. Push-to-Talk means that you’ll need to use your “trigger” which is defaulted in the voice chat menu to your middle mouse button. Depress your middle mouse button to talk, and release it to mute your mic. This is very important if you’re attending an event where someone else is speaking.

Toward the bottom of the Voice Chat tab is a button labeled “Device Settings”. Click on the Device Settings button and insure your headset is selected for input and output.
You can also turn your voice on to talk by clicking on the “Talk” button (Fig-20) from the menu located on the right bottom corner of your screen.

To “lock” your microphone on, press the lock icon button (Fig-21). The “Talk” button will be encircled by a tan ring highlight depicting that your mic is locked open. Be aware that any noise you make, or any noise made in the background will likely transmit over your open mic to the entire room. We recommend you do not leave your mic locked open as this most often results in disrupting any event you attend.

Please note that voice must be enabled in order for the Voice options at the bottom of your screen to appear. If you don’t see them, make sure voice is enabled in Edit > Preferences > Voice Chat as described earlier.

Proximity-Based and Group Voice Chat

“Proximity-based” voice usage is based on and altered by changes in physical in-world proximity, in which you hear speakers more loudly when your avatar is closer to them. “Group” voice chat enables you to speak with other Second Life Residents no matter where they are on the Grid.

Three types of voice chat are available:

Proximity-Based Voice Chat – allows you to voice chat with nearby avatars (automatic)
Group Voice Chat – allows you to voice chat with others members of your Second Life groups or groups of your friends no matter where they are in-world
One-to-One Voice Chat – allows you to voice chat with one and only one other person no matter where they are in-world

You can initiate Group Voice and One-to-One Voice Chat by using the “Communicate” button in the bottom left corner of the viewer.

This will open your “communicate” box (Fig-22), a unified interface for both voice and text chat. To clarify, you do not need to be in the same area with another avatar or group to take part in one-to-one and group voice chat. Simply double click (PC) or click (Mac) on the person or group you want to chat with. Select IM/Call. This will open a new window in your “Communicate” box. At the top of this window you’ll see a button labeled “Join Call”. Click on the button to initiate, or join a call with that group or person.
Increasing Voice Volume - Speaker / Presenter

During an event, some people cannot hear the speaker very well and need to adjust the speaker’s volume. To do this open the Active Speakers box by clicking on the chat bubbles (Fig-23) in the lower right hand corner of your screen.

A popup for Active Speakers will appear. Select the name of the person you wish to hear and increase the volume by adjusting the slider at the bottom of the Active Speakers window (Fig-24).
Chat: How to Talk with Text

Press Enter to display the chat bar at the bottom of the screen, type what you want to say, and press Enter again to say it. Anyone (or anything) near you will see your text (Fig-25).

At the bottom of your screen on the left hand side are two buttons, Communicate and Local Chat. Select both of those. Stretch the Local Chat window to a comfortable size to insure you miss none of the “text based” conversation. (As shown in Fig-26, the Local Chat window is open and in Fig-27 has been stretched just like you’d stretch any window.)

You can practice chatting as you move round the island, or ask any questions you have if there are other people nearby. Chat range is 20 meters in Second Life. Your text chat will not go beyond this range, so if someone is far away from you, and you type chat in the world, they will not see it.

If you want to see what has been said after it has faded out, use Ctrl + H to bring up the chat history window in case you’d closed it. To leave chat mode, hit the Esc button.
IM or Instant Messaging in SL

You can talk directly to another person without anyone else hearing you using instant messaging. Right-click on their avatar. A pie menu will appear (Fig-28). Select “Send IM” to open an Instant Message window. (Fig-29). You can also open your Friends tab on the “Communication” box, double click on a friend and start an IM or private voice chat with them.
Audio/Video and PowerPoint in Second Life

QuickTime must be installed on your computer in order to hear and see audio/video in Second Life. Insure you have the latest version installed prior to any event you want to attend featuring music or video.

To enable media in Second Life, select your “Edit” menu from the left-hand top of your screen. Select “Preferences” from the drop-down menu. Select the Audio & Video tab on the left. To the right you’ll see a number of controls and options. Insure that “Play Streaming Music When Available”, “Play Streaming Media When Available” and “Automatically play media” are checked. Click on Apply. Click on OK (Fig-30).

In the lower right hand corner of your screen are control panels for media. Hovering your cursor over each of the symbols will identify what action will occur should you select that symbol. You can also control volume here by increasing or decreasing the slider next to the speaker icon (Fig 31).
Using Your Camera (VERY IMPORTANT)

Key to Second Life is your ability to “see”. This includes your surroundings, presentations, signs, or other items of interest. Your view in SL isn’t fixed to your avatar; you can move your camera around to get a better view of things, without ever moving. This can be a big help in meetings, or to see what’s going on around you. There are two main options, 1) using your Camera View or, 2) using a combination of mouse and keys. Both options are described below.

Camera View:

In the top left hand corner of your screen, click on the View button. A drop down menu will appear (Fig-32). Select Camera Controls. A new box will have appeared at the bottom of your screen (Fig-33). It has blue circled directional arrows on the left and right side, with a slider in the center for zooming in or out.

The control on the left hand side rotates your view from left to right, overhead, and underneath. The control on the right will move your camera from side to side or up and down. Play with these a few minutes and get familiar with them.

For more precise control, hold the Alt key and click on the person, object, terrain, etc. that you wish to view. Your view will center on that object and if the person or object you’re viewing moves, your camera will track the movement.

To look behind you: press and hold the Alt key. Your cursor will become a magnifying glass. While holding the Alt key, use the left and right cursor keys to look behind and around.

Mouse and Keyboard Controls:

You can use the mouse to drag the camera around as well. Try the following combinations to click and drag the camera into almost any position:

- Alt+drag will spin the camera around the object (move left/right), as well as zoom in (move up/down).
- Ctrl+Alt+drag will spin the camera around the object at all angles (left/right as well as up/down).
- Ctrl+Shift+Alt+drag will move the camera up/down/left/right along the plane of your screen.
  This lets you reposition the camera independent of the object.
- To reset the camera back to normal, hit Esc, or just start walking.
Landmarks aka How to Get Back To That Place You Liked

Traveling in Second Life is much like going on a road trip. You remember the great places and tend to forget the bad. However, getting back to the great place is much more confusing in Second Life than it is in the physical world.

Before you start experimenting, select World at the top of your screen. Select Create Landmark Here (if you’re on Kelley Executive Partners’ island (Fig-34)). Now you have one more convenient way to get back to us. You can generally do this anywhere you go in Second Life. All your landmarks will be stored under the “Landmarks” folder in your Inventory (Fig-35).

![Figure 34](image-url)

![Figure 35](image-url)
To find an event, location/place, store, or other, one generally uses the “Search” button located at the bottom (or top) of your screen. Open Search. Select the “Places” tab. In the “Find” Box, type IBM (or whatever you wish). Click on the “Search” button in this popup window (Fig-36). If you typed in IBM, you’ll have nearly 30 “public” locations you can visit. Select one and click on the teleport tab.

Once you’ve found somewhere you’d like to revisit, it’s a good idea to create a landmark. Create one now by selecting the “World” menu at the top your screen and choosing “Create Landmark Here”. Close any open pop-ups (like the one you get when you create a landmark) you don’t want visible by clicking on the X in the upper right hand corner.

People as well as objects can also give you landmarks for places they think you’ll be interested in or for the location you’re currently at.

There is plenty of extra help, freebies and information on the Help Island – Public, and the New Citizens Plaza, so they’re well worth a visit when you have a chance. The Ivory Tower is a great place to learn about building in Second Life and it shows what’s possible when you leave PowerPoint in the real world!
Now that you’ve got some landmarks, open your inventory, look in your “Landmarks” folder and double click on one of them to be teleported immediately to that location.

**Note:** You do not always teleport directly to locations in Second Life; depending on your destination you may arrive at the nearest “Telehub”. You then may have to walk, fly, or ride the rest of the way (which may be several hundred meters). Your intended destination will be marked with a red arrow and a pillar of light—feel free to fly straight there.

**Teleporting Within a Sim or Sims (Island)**

Most well constructed sims (islands) have teleport features throughout. The teleports are usually well marked with signage stating it’s a teleport, and to where. Some have instructions on how to use them, some don’t.

Many have 3D island maps depicting various locations. When hovering your mouse over the top of a location, your mouse may turn into a picture of a chair. Left click on that spot and you will be teleported there.

Another common teleport requires you to right click on the name of a place located on a sign, and select teleport. Some have teleport “pads” that you right click on and select “sit”. Once you’ve enabled the appropriate action, your teleport will take place.
Changing Your Appearance

In Second Life, you can change your avatar to look like anyone, or anything, you want, be it humanoid, furry (a fox for example), alien, fantasy or other. Assuming you are coming into SL for business reasons, it’s likely you’ll want to have a human avatar. You can always change your mind later—very easy to transform.

To open your inventory click the ‘Inventory’ button on the bottom right corner of your screen, or use Ctrl+I. Alternatively you can drag clothes from your inventory over your avatar to wear them. (Fig-38)

A folder can contain a complete outfit or an entire new body shape -- even a new hairstyle! Open the ‘Clothing’ folder in your Library (this is located at the bottom of your inventory list), and drag any of the shapes or outfits onto your avatar to try them on. (Fig-39 and 40)
**Figure 39**

**Figure 40**
You can change nearly anything about your appearance, not just your clothes: height, weight, hair, face, skin color. Right-click on yourself and select “Appearance (Fig-41).”

There are an infinite number of options so it’s best to just experiment. Click the “Randomize” button for a complete change if you dare!